
A4 サイズの用紙をお使いの方へ: このドキュメントは US Letter サイズで提供されています。そのまま A4 サイズの用紙に印刷するこ

ともできますが、下の余白が多くなります。 

ドキュメントのサイズを A4 に変更する手順:  

1. Word でページ レイアウトを開き、サイズで A4 を選択します。 

2. 目次ページ (目次の任意の場所) に移動して F9 を押し、目次のページ番号を更新します。 

3. 最後のページ (索引の任意の場所) に移動して F9 を押し、索引のページ番号を更新します。 

4. 新しい名前でファイルを保存します。 
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このガイドについて 

このガイドには、TestComplete のインストールとメンテナンスに関するシステム要件、重要な注意事項、操作

手順の説明が含まれています。 
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インストールの前に 

インストール時の注意事項 

TestComplete をインストールする前に、次の要件が満たされていることを確認してください。 

• TestComplete をインストールするコンピューターが 6 ページの「システム要件」で説明されている

ハードウェア要件とソフトウェア要件を満たしていること。 

• 「ユーザー権限」の説明にあるようにユーザー アカウントに必要な権限があること (12 ページ)。 

• TestComplete は、"すべてのユーザー" モードでインストールされます。つまり、インストール後、イン

ストールしたユーザーだけでなく、コンピューターを使用するすべてのユーザーが TestComplete を

利用できます。 

TestComplete 10 以前のバージョンがインストールされているコンピューターにも TestComplete 14 を正常に

インストールして使用することができます。既存の旧バージョンの TestComplete は TestComplete 14 にアッ

プグレードされないことにも注意してください。以前のバージョンがインストールされている場合には、

TestComplete 14 にアップグレードするか、または共存させるかを検討してください。 

• 以前のバージョンから TestComplete 14 へアップグレードするには、最初に古いバージョンをアンイ

ンストールしてください。30ページの「TestComplete のアンインストール」を参照してください。 

古いバージョンをアンインストールする前に、カスタマイズした TestComplete 設定を保存しておくと、

新しいバージョンのインストール後に設定を復元できます。詳細は、31 ページの「TestComplete 設

定のインポートとエクスポート」を参照してください。 

• 以前のバージョンと TestComplete 14 を共存させる場合には、特にほかの準備は必要ありません。 

TestComplete 11 および 12 で作成されたテスト プロジェクトは、ほとんど変更することなく (あるいは全く変更

せずに) TestComplete 14 で動作します。TestComplete 10 以前のバージョンで作成されたテストの場合は、

移行処理が必要なことがあります (TestComplete ヘルプの「Migrating Projects Created in Earlier Versions to 

TestComplete 14」を参照してください)。ただし、TestComplete 14 で作成または編集されたプロジェクトは旧

バージョンとは互換性がないことに注意してください。 

インストールの前準備 

このセクションでは、TestComplete を正常にインストールして使用するために必要なハードウェア、ソフトウェ

ア、ユーザー権限を説明します。TestComplete の最新のシステム要件については、Web サイトを参照してく

ださい。 

➢ https://support.smartbear.com/testcomplete/docs/general-info/system-requirements.html 

https://support.smartbear.com/testcomplete/docs/general-info/system-requirements.html
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システム要件 

サポートされる Windows バージョン 

Windows 10 

(32 ビット/64 ビット エディションの両方) 

Windows Server 2019 

Windows Server 2016 

Windows 8 および 8.1 

(32 ビット/64 ビット エディションの両方) 

Windows Server 2012 

Windows Server 2012 R2 

Windows 7 Service Pack 1 

(32 ビット/64 ビット エディションの両方) 

Windows Server 2008 R2 

(Server Core インストールは WoW64 コンポーネン

トがインストールされている場合のみサポートされ

ます。) 

既知の問題がある更新プログラムを除き、Windows の最新のサービスパックとアップデートを適用すること

を推奨します。既知の問題がある更新プログラムのリストは、TestComplete のドキュメントで確認できます。 

➢ https://support.smartbear.com/testcomplete/docs/general-info/configuring/windows-specifics.html 

推奨するシステム要件 

• Microsoft Windows 10 (64 ビット)。 

• インテル Core i5 プロセッサーまたはインテル Core i7 プロセッサー (第 3 世代)。 

• RAM 16 GB 以上。 

• 5 GB 以上のシステム ディスク上の空き容量。 

• 2 GB の空きディスク容量 (インストール時)、さらにテストの実行時に一時ファイル用の空きディスク

容量が必要 (下記の「必要な空きディスク容量」を参照してください)。 

• 1920×1084 以上の解像度のモニター (100% DPI を使用する場合)。より高い DPI 値を使用する場

合は、より高解像度が要求されます。 

• マウスまたはその他のポインティング デバイス。 

最小システム要件 

• Windows 7 Service Pack 1。 

• インテル Core 2 Duo プロセッサー 2 GHz 以上。 

• RAM 2 GB。 

• 4 GB 以上のシステム ディスク上の空き容量。 

• 1.5 GB の空きディスク容量 (インストール時)、さらにテストの実行時に一時ファイル用の空きディスク

容量が必要 (下記の「必要な空きディスク容量」を参照してください)。 

• 1024×768 以上の解像度のモニター (100% PDI を使用する場合)。 

• マウスまたはその他のポインティング デバイス。 

https://support.smartbear.com/testcomplete/docs/general-info/configuring/windows-specifics.html
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必要な空きディスク容量 

TestComplete は、テスト実行時に一時ファイルを作成して使用します。TestComplete が必要とする空きディ

スク容量は、プロジェクトのサイズに依存します。小さなプロジェクトを実行するには、システム ディスク上に 

500 MB の空きディスク容量が必要です。大きなプロジェクトを実行するには、1 ～ 2 GB の空きディスク容量

が必要になります。 

テストを実行する前に、空きディスク容量に注意してください。テスト実行時にシステム ディスクに空き容量

がない場合、TestComplete は誤動作します。たとえば、TestComplete はコマンドへの応答を停止する、テス

ト イベントを生成しない、パネル レイアウトが壊れるなどの可能性があります。 

ライセンス 

TestComplete のライセンスをアクティベートして使用するには、コンピューターがインターネットに接続され

ている必要があります。ライセンスの種類によっては、アクティベーションのみ、またはアクティベーションと

使用の両方にインターネット接続が必要になります。 

キーベースのフローティング ユーザー ライセンスで TestComplete を使用するには、ネットワーク接続が必

要です。 

詳細は、TestComplete ヘルプの「Licensing」セクションを参照してください。 

仮想マシンでの TestComplete の実行 

Microsoft Virtual PC や VMware Workstation などの仮想マシンでは、システム リソースを著しく消費します。

一般的に、仮想マシン上でのアプリケーションの実行は、デスクトップ コンピューター上よりも遅くなります。

同時に 1 台のコンピューター上で実行する仮想マシンが多いほど、動作が遅くなります。仮想マシン上で 

TestComplete を使用するには、仮想マシンが適度なパフォーマンスを得るために、推奨システムよりも高い

パフォーマンスのホスト コンピューターを使用してください。 

重要: 仮想マシンで TestComplete 製品版を使用するには、キーベースのフローティング ユーザー ライセン

スが必要です。詳細は、TestComplete ヘルプの「Licensing」セクションを参照してください。 

その他の要件 

TestComplete Platform 

Microsoft Azure DevOps 統合 

TestComplete のテストをビルドおよびリリース パイプラインの一部として実行するには: 

• 次のいずれかのバージョンの Team Foundation Server が必要です。 

Azure DevOps Server 2019 On-Premises。 

Team Foundation Server 2010 - 2018 On-Premises。 

Azure DevOps Services (旧称 Visual Studio Team Services または VSTS)。 



インストールの前に 

www.smartbear.com TestComplete by SmartBear Software 

8 

注意: TestComplete テストを実行するには、セルフホスト (プライベート) エージェントを使用して

ください。Microsoft によりホストされたエージェントでの TestComplete テストの実行はサ

ポートされていません。 

ホストされたエージェントとプライベート  エージェントの詳細については、

docs.microsoft.com/en-us/azure/devops/pipelines/agents/agents を参照してください。 

• テストが実行されるコンピューター上で、実行するタスクと使用する Team Foundation Server のバー

ジョンに応じて、次のソフトウェアをインストールする必要があります。 

Team Foundation Build Service 

- または - 

Build and Release Agent for Windows 

- または - 

Test Agent for Microsoft Visual Studio 

Microsoft Office Excel データ接続 

テストで Microsoft Office Excel 2007 - 2013 ファイルを使用するには、コンピューターに Microsoft Office 

12.0 Access データベース エンジン OLE DB Provider がインストールされている必要があります。 

 TestComplete と同じビット数のデータ プロバイダーを持つことが重要です。そうしないと、「必要な

データ ソース ドライバーがインストールされていません」というエラーメッセージが表示されます。した

がって、64 ビットの TestComplete を使用する場合は、64 ビット バージョンのプロバイダーが必要で

す。 

次のソフトウェアの一部としてデータ プロバイダーを入手できます。 

• Microsoft Access データベース エンジン 2010 再頒布可能パッケージ。Microsoft の Web サイトから

ダウンロードできます。 

➢ https://www.microsoft.com/en-us/download/details.aspx?id=13255 

 Microsoft Office 2010 が 32 ビットの場合、64 ビット プロバイダーのインストールは失敗し

ます。この場合、次の手順を実行してインストールします。 

1. 対応するバージョンのインストーラーを /passive オプションで実行します。 

2. レジストリ エディターを実行します。これを行うには、スタート メニューを開き、

regedit と入力して ENTER を押します。 

3. 次のレジストリ キーを見つけます。 

HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Office\14.0\Common\FilesPaths 

4. mso.dll レジストリ値を削除するか、名前を変更します。 

5. そうしないと、最初の Excel 実行後にドライバーが破損します。 

• Microsoft Office Excel 2007 - 2013。 

https://docs.microsoft.com/en-us/azure/devops/pipelines/agents/agents?view=vsts
https://www.microsoft.com/en-us/download/details.aspx?id=13255
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• 2007 Office System Driver: Data Connectivity Components。Microsoft Web サイトからダウンロード

できます。 

➢ https://www.microsoft.com/en-us/download/details.aspx?id=7020 

ADO サポート 

テストで  Microsoft Active Data Objects (ADO) を使用するには、Microsoft Data Access Components 

(MDAC) 2.1 またはそれ以降がコンピューターにインストールされている必要があります。次の場所から最

新バージョンの MDAC をダウンロードできます。 

➢ https://docs.microsoft.com/en-us/previous-versions/aa937730(v=msdn.10) 

HP Quality Center 統合 

TestComplete Connector for HP Quality Center を利用するには、HP Quality Center Connectivity 

Add-In がコンピューターにインストールされている必要があります。このアドインは、Quality Center の 

Add-ins Page からダウンロードできます。 

Atlassian Jira 統合 

Atlassian Jira データベースに直接 TestComplete ログから問題を送信するには: 

• Jira Server 5.0 - 7.12 または Jira Cloud。 

• Jira は、リモート API コールを受け付けなければなりません。 

• ターゲット Jira プロジェクトの問題は、 

 Summary フィールドと Description フィールドがなければなりません。 

 添付を許可している必要があります。 

Jira の設定、Jira プロジェクトの管理については、Jira ドキュメントを参照してください。 

デスクトップ テスト 

.NET および WPF アプリケーション テスト 

.NET アプリケーションをテストするには、Microsoft .NET Framework 2.0 - 4.8 が必要です。 

WPF アプリケーション テスト 

WPF アプリケーションをテストするには、Microsoft .NET Framework 3.0 - 4.8 が必要です。 

Java アプリケーション テスト 

Java アプリケーションをテストするには、Java 実行環境 (JRE) 5 - 11 がコンピューターにインストールされてい

る必要があります。TestComplete は、32 ビットおよび 64 ビットの両方の Java バージョンをサポートします。 

https://docs.microsoft.com/en-us/previous-versions/aa937730(v=msdn.10)
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Windows ストア アプリケーション テスト 

Windows ストア アプリケーションをテストするには、TestComplete を 64 ビット オペレーティング システム上

の次のサブフォルダーにインストールしなければなりません: <Program Files> (または <Program Files 

(x86)>) フォルダー。 

Web テスト 

Web ブラウザー 

Web テストをレコーディングするには 

次のいずれかの Web ブラウザーがコンピューターにインストールされていなければなりません。 

• Microsoft Edge (32ビットおよび 64ビット バージョンの両方)。 

注意: Chromium ベースでない古い Edge バージョンはサポートされていません。 

• Internet Explorer 11 (32 ビットおよび 64 ビット バージョンの両方)。 

Internet Explorer 11 の Modern UI (Metro) バージョンは、現在サポートされていません。 

• Google Chrome 91 (32ビットおよび 64ビット バージョンの両方)。 

Modern UI (Metro) モードで実行している Chrome は、現在サポートされていません。 

• Internet Explorer 78 ESR、83 - 88 (32 ビットおよび 64 ビット バージョンの両方)。 

注意: Firefox 上でテストを実行するには、ブラウザーを single-process mode に切り替えてくだ

さい。詳細は、TestComplete ドキュメントで「Preparing Firefox for Web Testing」を参照してください。 

• Chromium Embedded Framework (CEF) バージョン 85.0.4183 以前 (CEF3 1750 を除く) を使用す

る .NET、Java、およびネイティブ アプリケーション (C++、Delphi など)。 

注意: WPF コントロールを使用する CEF アプリケーションでは、84.0.4147 以前がサポートされて

います。 

• Electron バージョン 1.8.2、2.0.2、3.0.2、4.0.2、5.0.0、6.0.0、6.1、7.0.0、7.1、8.0 - 8.5、9.0 - 9.2、10.0 

- 10.1、11.0.0 で作成されたアプリケーション。 

注意: 現在、TestComplete は、Electron 9.x および 11.0.0 で作成されたアプリケーションで、グ

ローバル サンドボックス モード (app.enableSandbox メソッド) が有効な場合、サポート

していません。 

リモート モジュールを無効にして Electron アプリをビルドした場合、オブジェクト認識の問

題が発生する可能性があります。 
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• 埋め込みの Microsoft WebBrowser コントロールを使用するアプリケーション。 

注意: Firefox および Chrome の最新バージョンは、頻繁にリリースされます。最新バージョンの 

Firefox および Chrome のサポートは、パッチとして提供され、SmartBear の Web サイトから

ダウンロードできます。 

➢ https://support.smartbear.com/downloads/testcomplete/firefox-patches/ 

➢ https://support.smartbear.com/downloads/testcomplete/chrome-patches/ 

テスト用に Web ブラウザーと  TestComplete を準備する必要があります。詳細は、製品ドキュメントの

「Preparing Web Browsers」セクションを参照してください。 

 どのブラウザーをテストのレコーディングに使用するかは、どのブラウザーをテストの実行に使用する

かに影響しません。 

Windows 環境でテストを実行するには 

上記のブラウザーのいずれかがインストールされていなければなりません。 

デバイス クラウドでテストを実行するには 

Selenium WebDriver がサポートする任意の Web ブラウザー (例: Safari、Chrome for Mobile など) を使用で

きます。詳細は、製品ドキュメントの「Preparing Web Browsers」セクションを参照してください。 

AIR アプリケーション テスト 

AIR アプリケーションをテストするには、コンピューターに Adobe AIR 2、3、または 17 がインストールされて

いる必要があります。次の場所から AIR をダウンロードできます。 

➢ https://get.adobe.com/air 

また、AIR インストーラー パッケージでインストールされていない AIR アプリケーションを実行するには、

AIR Debug Launcher が必要です。これは、次の場所からダウンロードできる AIR SDK に含まれています。 

➢ https://www.adobe.com/devnet/air/air-sdk-download.html 

Silverlight アプリケーション テスト 

Silverlight アプリケーションをテストするには、Silverlight 4 (v. 4.0.50826 以降) または Silverlight 5 がインス

トールされている必要があります。次の場所から最新バージョンの Silverlight をダウンロードできます。 

➢ https://www.microsoft.com/getsilverlight 

モバイル Web テスト 

モバイル Web アプリケーションをテストするには、Google Chrome 84 がインストールされている必要があり

ます。 

WCF サービス テスト 

WCF サービスをテストするには、Microsoft .NET Framework 3.5 または 4.0 が必要です。 

https://support.smartbear.com/downloads/testcomplete/firefox-patches/
https://support.smartbear.com/downloads/testcomplete/chrome-patches/
https://get.adobe.com/air
https://www.adobe.com/devnet/air/air-sdk-download.html
https://www.microsoft.com/getsilverlight
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モバイル テスト 

Android テスト 

• Android アプリケーションをテストするには、コンピューターに以下のソフトウェアがインストールされ

ている必要があります。 

▪ Java SE 実行環境 (JRE) または Java SE 開発キット (JDK) 8 以降。 

注意: サポートされている任意のバージョンの Java SE 実行環境 (JRE) または Java SE 開発

キット (JDK) を使用できます。推奨バージョンは 8 です。 

▪ Android SDK ツール。次の場所から入手できます。 

https://developer.android.com/studio#command-tools 

• Android デバイスまたはエミュレーターは、少なくとも 512 MB のメモリが必要です。テストするデバ

イスの CPU および画面解像度に関する特定の要件はありません。 

• 物理デバイスを使用する場合は、USB ケーブルを使用してコンピューターに接続する必要があり

ます。 

iOS テスト 

• iTunes の最新のデスクトップ バージョンがコンピューターにインストールされている必要があります。

次の場所からダウンロードできます。 

➢ https://www.apple.com/itunes/ 

注意: TestComplete は、iTunes の Windows ストア バージョンと互換性がありません。iTunes 

の汎用デスクトップ  バージョンをダウンロードするには、 iTunes Web サイトの 

Download ページで Looking for other versions セクションから Windows を選

択します。 

• iOS デバイスは、USB ケーブルを使用してコンピューターに接続する必要があります。 

ユーザー権限 

TestComplete のインストール 

TestComplete のインストール、変更、修復、アンインストールには、管理者権限が必要です。対象コンピュー

ターには Administrator または Administrators グループのメンバーとしてログインしなければなりません。 

ネットワークから TestComplete をインストールする場合はその共有環境の読み取り/実行権限を持つドメイン 

アカウントでログインする必要があります。 

TestComplete の使用 

Windows Vista、Windows 7、およびそれ以降の Windows バージョンでは、TestComplete の一部の機能の

使用に管理者権限が必要です。詳細については、TestComplete ヘルプの「Using TestComplete With 

Administrator Privileges」を参照してください。 

https://developer.android.com/studio#command-tools
https://www.apple.com/itunes/
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管理者権限のないアカウントでの TestComplete の使用については、TestComplete ヘルプの「Working 

With TestComplete Under a User Account」を参照してください。 

Android アプリケーション テストの準備 

TestComplete で Android アプリケーションをテストするには、モバイル テストの作成と実行を行うすべてのコ

ンピューターに Java 実行環境と Android SDK をインストールする必要があります。 

Java JRE または JDK のインストール 

Java JRE または JDK バージョン 8 以降をインストールする必要があります。次の場所からダウンロードでき

ます。 

➢ https://java.com/en/download/windows_manual.jsp 

64 ビット版の Windows では、64 ビットまたは 32 ビットの Java バージョンをインストールできます。一部の 

Android SDK パッケージは 32 ビットの Java バージョンでのみ動作するため、64 ビットの Java バージョンを

使用する必要がない場合は、32 ビットの Java バージョンをインストールすることを推奨します。 

Android SDK のダウンロードとインストール 

Android SDK の最新バージョンは次の場所からダウンロードできます。 

➢ https://developer.android.com/sdk/index.html 

このサイトでは、いくつかの SDK パッケージが提供されています。 

• Android Development Tools バンドル (デフォルトのダウンロード) 

Android アプリケーションの開発に使用される SDK と Eclipse IDE が含まれた .zip ファイルで

す。.zip ファイルをダウンロードして、コンピューター上のフォルダーに展開します。 

TestComplete のインストール時に Android SDK のパスを指定するように求められたら、<ADT 

bundle>\SDK フォルダーを指定します。 

• SDK ツール 

Eclipse IDE が不要な場合は、SDK のみダウンロードし、インストールすることができます。 

注意: コンピューターに Java JRE または JDK がすでにインストールされていなければなりません。 

SDK ファイルをダウンロードするには、次の操作を行います。 

1. 次の SDK ダウンロード ページにアクセスします。 

➢ https://developer.android.com/sdk/index.html 

そして、Download for Other Platforms セクションを展開します。 

2. SDK Tools セクションから installer_rXX.X-windows.exe ファイルまたは android-sdk_rXX.X-windows.zip 

ファイルをダウンロードします。 

3. SDK をインストールして、Android SDK Manager を実行します。 

https://java.com/en/download/windows_manual.jsp
https://developer.android.com/sdk/index.html
https://developer.android.com/sdk/index.html
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 .exe 形式のインストール パッケージをダウンロードした場合は、起動してウィザードの指示に従

います。インストール ウィザードの最後のページで、Start SDK Manager を選択します。インス

トール ウィザードを閉じると、Android SDK Manager が起動します。 

– または – 

 .zip 形式のパッケージをダウンロードした場合は、コンピューター上のフォルダーに展開します。

そして、<Android SDK>\SDK Manager.exe を起動します。 

4. SDK Manager で次の項目を選択します。 

 Android SDK Platform-tools 

 Android SDK Build-tools 

 Google USB Driver (http://developer.android.com/sdk/win-usb.html にリストされているデバイス

でテストを実行する場合)。 

 Android エミュレーターを使用してテストする場合は、次の項目を選択します。 

▪ Intel x86 Atom System Image for Android 4.0.3 (API 15) 以降 

▪ Intel x86 Emulator Accelerator (HAXM) 

 

5. [Install packages] をクリックし、ライセンス許諾契約に同意して、インストールを続行します。 

6. SDK Manager を閉じます。 

https://developer.android.com/sdk/win-usb.html
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TestComplete のインストール パッケージの入手 

評価版パッケージ 

次の SmartBear の Web サイトで評価版のリクエストを送信後、TestComplete 評価版パッケージのダウン

ロードが開始します。 

➢ https://smartbear.com/product/testcomplete/free-trial/  

ダウンロード後、ファイル名を変更しないでください。 

注意: 評価版パッケージには、製品版パッケージに含まれるすべてのモジュールが含まれています。購入

後、製品版パッケージをダウンロードし、インストールする必要はありません。TestComplete 評価版で製品

版ライセンスをアクティベートするだけです。 

製品版パッケージ 

TestComplete インストール パッケージは、SmartBear の Web サイトの My SmartBear セクションから入手で

きます。 

• ブラウザーで https://my.smartbear.com を開きます。 

• メール アドレス、セキュリティ ID、パスワードを対応するテキスト ボックスに入力し、[Login] をクリッ

クします。 

これらの情報は、TestComplete 購入時に SmartBear からお客様が指定されたメール アドレスに送

ら れ ま す 。 こ の メ ー ル を 受 け 取 っ て い な い 場 合 、 あ る い は 紛失 し た 場 合 は 、

https://my.smartbear.com ページで [Resend my login info] をクリックしてください。 

• 次に、[My Products] でダウンロードする TestComplete のバージョンをクリックします。バージョン

の詳細が記載されたページが開きます。 

• 次に、[License Details] セクションに表示されるライセンスの種類とライセンス キーを作成します。

この情報は、TestComplete でライセンスのアクティベート手続きを行う際に必要です (20 ページの

「TestComplete のライセンス」を参照してください)。 

• [Downloads] セクションのリンクをクリックしてダウンロードを開始します。 

• ファイルのダウンロードのダイアログで [Save] をクリックし、TestComplete インストール パッケージの

保存先を指定します。 

TestComplete のフローティング ライセンスを使用する場合は、ライセンス マネージャー (License Manager) 

のインストール パッケージもダウンロードする必要があります。ライセンス マネージャーは、社内でフロー

ティング ライセンス サーバーとして使用されているコンピューターにインストールする必要があります。 

フローティング ライセンスの詳細は、20 ページの「TestComplete のライセンス」を参照してください。 

https://smartbear.com/product/testcomplete/free-trial/
https://my.smartbear.com/
https://my.smartbear.com/
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TestComplete のインストール  

TestComplete をインストールする前に 

1. ライセンス許諾契約をお読みください。TestComplete をインストールすることにより、この契約書に

同意したことになります。 

➢ https://smartbear.com/terms-of-use/ 

2. 5 ページの「インストールの前に」を参照して、コンピューターがハードウェア要件とソフトウェア要件

を満たしていることを確認します。 

TestComplete をインストールするには 

1. TestComplete がすでにインストールされており、実行中の場合は終了します。 

2. Web ブラウザーや Microsoft Visual Studio、テスト アプリケーションなど TestComplete のファイルを

使用している可能性があるすべてのアプリケーションを終了します。 

3. Windows エクスプローラーで TestComplete のインストール パッケージをダブルクリックします。イン

ストール ウィザードが開始します。 

4. Intelligent Quality アドオンを有効にするには、次のページでリンクをクリックして、サードパーティの

使用許諾契約をお読みください。ライセンス条項に同意する場合は、 [Intelligent Quality 

Add-on] チェックボックスを選択したまま、[Next] をクリックします。 

 

https://smartbear.com/terms-of-use/
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 Intelligent Quality アドオンは、別途有効なライセンス必要になります。アドオンのライセンスを

既にお持ちの場合は、インストールが完了した後で、ライセンスを有効にすることができます。

アドオンのライセンスをお持ちでない場合は、アドオンを購入して有効にする必要があります。

アドオンの価格および購入に関しては、弊社までお問い合わせください。 

サードパーティの使用条件に同意しない場合、またはアドオンを使用する予定がない場合は、

[Intelligent Quality Add-on] チェックボックスをオフにして、[Next] をクリックします。 

注意: TestComplete のインストール時に Intelligent Quality アドオンをインストールしない場合、

後で [File] > [Install Extensions] ダイアログからインストールできます。 

5. 次のページで、TestComplete をインストールするフォルダーを選択します。 

 

注意: Windows ストア アプリケーションをテストするには、TestComplete を <Program Files> (または 

64 ビット版の Windows の場合は <Program Files (x86)>) フォルダー以下のサブフォルダーにイン

ストールする必要があります。TestComplete を別のフォルダーにインストールする場合、ウィザード

が警告します。 

6. [Install] をクリックしてインストールを開始します。通常、ファイルのコピーと環境設定にはあまり時

間がかかりません。 

注意: 指定したインストール フォルダーにファイルが存在する場合、ウィザードはそれらを上書きし

ます。その場合、警告メッセージが表示され、続行するための確認を求められます。 

注意: 製品のインストール中に問題が発生した場合、インストール プログラムは、カスタマー ケア チームに

インストール ログを送信することを提案します。 
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インストール後 

インストールが完了すると、インストール ウィザードは自動的に TestComplete を実行します。 

TestComplete は、お使いのコンピューターで有効なライセンスを検索します。ライセンスが見つからない場

合、製品のアクティベーションを求めるダイアログボックスが表示されます。まだ TestComplete を評価してい

ない場合は、評価を開始できます。 

アクティベート手順の詳細は、20 ページの「TestComplete のライセンス」を参照してください。 
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評価版からのアップグレード 

TestComplete の評価版にはインストール後 30 日間使用できる TestComplete の評価版ライセンスが含まれ

ています。 

TestComplete の評価版は、この期間中または期間後に正式ライセンスのアクティベート手続きを行うことに

より、製品版にアップグレードできます。 

評価版の TestComplete をアンインストールして、製品版パッケージを使用して TestComplete をインストー

ルしなおす必要はありません。製品版ライセンスをアクティベートするだけです。手順は、20 ページの

「TestComplete のライセンス」を参照してください。 
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TestComplete のライセンス 

概要 

TestComplete を使用する前に、ライセンスをアクティベートする必要があります。ライセンスの種類によって、

ライセンスのアクティベーション、使用、管理の方法が異なります。 

TestComplete には、次の 2 種類のライセンスがあります。 

• キーベース — 従来のライセンスです。製品をアクティベートするには、ライセンス キーを指定するか、

ローカル ネットワーク上で動作するライセンス マネージャーからライセンスを取得します。 

• SmartBear ID ベース — TestComplete 14.9 で導入された新しいライセンスです。製品をアクティ

ベートして使用するには、SmartBear アカウントを指定します。このアカウントがない場合は、作成す

る必要があります。アカウントの設定を表示して管理するには、新しい SmartBear ライセンス管理

ポータル (https://manage.smartbear.com) を使用します。 

現在、SmartBear ID ベース ライセンスは、一部の評価ユーザーにのみ提供しています。将来的には規模を

拡大し、キーベース ライセンスを ID ベース ライセンスに置き換える予定です。 

このセクションの情報は、通常のキーベース ライセンスに関するものです。新しい ID ベース ライセンスの情

報は、https://support.smartbear.com/licensing/docs を参照してください。 

TestComplete キーベース ライセンス 

TestComplete には、2 種類のライセンスが用意されています。 

• Node-Locked (ノードロック) ライセンスは、TestComplete がインストールされたコンピューターに固定

され、ライセンスが登録されているシングル ユーザーのみに使用が許可されます。 

Node-Locked (ノードロック) ライセンスは仮想マシンでは使用できません 

• Floating User (フローティング ユーザー) ライセンスは、同一ネットワーク内のユーザー グループで

共有され、同時に任意の数のユーザーが TestComplete を使用できます。同時使用ユーザー数は、

ライセンスで指定された数を超えることはできません。 

ネットワーク内のコンピューター上で Floating User (フローティング ユーザー) ライセンスをアクティ

ベートします。このコンピューターは、License Manager PC となり、ネットワーク上の TestComplete 

ワークステーションからのライセンス リクエストを処理します。Floating User (フローティング ユー

ザー) ライセンスを TestComplete ワークステーションでアクティベートする必要はありません。 

評価版ライセンスは、Node-Locked (ノードロック) ライセンスです。Node-Locked (ノードロック) ライセンスに

適用される条件はすべて評価版ライセンスにも適用されます。 

評価版ライセンスのデータは、SmartBear の Web サイトからダウンロードした評価版インストール パッケージ

に組み込まれています。製品版ライセンスのデータは、Web サイトの  My SmartBear セクションの 

(https://my.smartbear.com) TestComplete 14 製品ページにあります。 

https://manage.smartbear.com/
https://support.smartbear.com/licensing/docs
https://my.smartbear.com/


TestComplete のライセンス  

© 2021 SmartBear Software https://support.smartbear.com/ 

21 

TestComplete のライセンスの詳細は、TestComplete ヘルプの「Licensing」セクションを参照してください。 

TestComplete 評価版ライセンスのアクティベート 

1. TestComplete 評価版パッケージをダウンロードします。SmartBear の Web サイトで Web フォームを

入力すると、自動的にダウンロードが開始されます。また、製品のリクエスト後に SmartBear から受

け取ったメールにもダウンロード リンクが含まれています。 

2. ダウンロードしたパッケージを実行して、コンピューターに TestComplete をインストールします。イン

ストール手順の詳細は、16 ページの「TestComplete のインストール」を参照してください。 

3. インストール後、TestComplete は [Welcome] ダイアログを表示します。[Start a 30-Day Trial] を

クリックします。TestComplete は、SmartBear Web サイトに接続して、アクティベーション データをダ

ウンロードし、コンピューターに適用します。処理が完了すると、TestComplete ウィンドウが表示さ

れます。 

エラーが発生した場合、TestComplete はエラーメッセージを表示します。画面の指示に従ってくだ

さい。 

インターネットに接続されていないコンピューターに TestComplete をインストールして、アクティベートするこ

ともできます。その場合、手動で SmartBear ライセンス サーバーとデータを交換する必要があります。 

1. 上記の手順に従って、TestComplete をダウンロードし、インストールします。 

2. [Welcome] ダイアログで評価版の開始を選択します。 

3. アクティベートに失敗するまで待ちます。TestComplete は、エラーメッセージを表示し、オフライン ア

クティベーションの使用を促します。オフライン アクティベーション モードを選択し、アクティベーショ

ン ウィザードの指示に従います。詳細は、25 ページの「手動アクティベート」を参照してください。 

製品版 Node-Locked (ノードロック) ライセンスのアクティベート 

TestComplete の Node-Locked (ノードロック) ライセンスの使用には、次の要件があります。 

• 物理 コンピューターに TestComplete をインストールして、ライセンスをアクティベートします。 

• 自動アクティベート (推奨) を使用する場合は、コンピューターがインターネットに接続されているこ

とを確認してください。 

• TestComplete Platform とモジュール (Desktop、Web、Mobile) のライセンス キーが別々に発行され

ている場合は、Platform のライセンス キーをアクティベート後に、各モジュールのライセンス キーを

アクティベートしてください。 

※ Platform とモジュールのライセンス キーが統合されている場合は、そのライセンス キーのみをア

クティベートしてください 

Node-Locked (ノードロック) ライセンスを TestComplete でアクティベートするには、次の操作を行います。 

• TestComplete を起動します。ローカル コンピューターおよびネットワーク内でアクティベートするライ

センスを検索します。 
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• コンピューターに TestComplete の以前のバージョンの Node-Locked (ノードロック) ライセンスがある

場合、TestComplete は SmartBear Web サイトに接続して、そのライセンスで利用可能なアップデー

トを確認します。 

アップデートが利用可能な場合 (これは、たとえば、保守が有効なライセンスをお持ちの場合に可

能です)、TestComplete は自動的にライセンスを更新し、ライセンスのアクティベートを促すメッセー

ジ ボックスを表示します。 

メッセージ ボックスで [Activate on this PC] をクリックします。TestComplete は、自動的にライセンス

をアクティベートします。 

• TestComplete はアクティベートするライセンスを検出できない場合、メッセージ ボックスにその旨表

示します。 

メッセージ ボックスで [Activate] をクリックします。 

これにより [License Management] ウィザードが起動します。 

• ウィザードの最初のページで、新しいライセンスをアクティベートするか、既存のライセンスのアク

ティベートを解除するかを選択します。 

コンピューターがインターネットに接続されていて、SmartBear ライセンシング  Web サイト 

(https://ls1.smartbear.com または https://ls2.smartbear.com、ポート 443) にアクセスできる場合は、

ウィザードが自動アクティベート モードを選択しアクティベートに必要なユーザー名、会社名、email、

ライセンス キー情報を入力するページを表示します。TestComplete が SmartBear の Web サイトに

接続して、ライセンスをアクティベートします。 

コンピューターがインターネットに接続されていない場合、または SmartBear ライセンシング Web サ

イトにアクセスできない場合は、手動によるアクティベートが必要になります。 

詳細は、「自動アクティベート」 (24 ページ) と「手動アクティベート」 (25 ページ) を参照してください。 

Floating User (フローティング ユーザー) ライセンスのアクティ

ベート 

TestComplete の Floating User (フローティング ユーザー) ライセンスの使用には、次の要件があります。 

• ネットワーク上の 1 台のコンピューターに特別な License Manager ユーティリティ をインストールし、

このコンピューターでライセンスをアクティベートするためにユーティリティを使用します。このコン

ピューターは、License Manager PC となり、ライセンスの利用を管理します。 

注意: Floating User (フローティング ユーザー) ライセンスをアクティベートするために、License 

Manager PC に TestComplete をインストールすることもできます。しかし、License Manager 

PC 上でテストを実行しない場合は、スタンドアロンの License Manager ユーティリティを使

用することを推奨します。 
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• TestComplete を実行するワークステーションで Floating User (フローティング ユーザー) ライセンス

をアクティベートする必要はありません。これらのワークステーションで TestComplete を起動すると、

アクティブな License Manager を自動的に検索し、実行するための許可をリクエストします。 

• TestComplete を実行するワークステーションは、ライセンスをチェックするために License Manager 

PC にネットワーク接続されていなければなりません。 

• TestComplete Platform とモジュール (Desktop、Web、Mobile) のライセンス キーが別々に発行され

ている場合は、Platform のライセンス キーをアクティベート後に、各モジュールのライセンス キーを

アクティベートしてください。 

※ Platform とモジュールのライセンス キーが統合されている場合は、そのライセンス キーのみをア

クティベートしてください 

License Manager PC の選択 

License Manager のフットプリントは小さいため、実行には特定のハードウェアやソフトウェアは必要ありませ

ん。License Manager をインストール/実行するコンピューターのシステム要件は以下のとおりです。 

• 物理マシンであること (仮想マシンではないこと)。 

• ローカル ネットワーク接続があること。 

• ワークステーションで TestComplete を実行する際に、常に稼動していること。 

一般に License Manager はネットワーク内の専用のサーバーにインストールされます。ただし、必要に応じ

て TestComplete がインストールされたコンピューターにインストールすることも可能です。 

License Manager PC の設定 

License Manager ユーティリティをインストールし、Floating User (フローティング ユーザー) ライセンスをアク

ティベートするには: 

1. Web サイトの My SmartBear セクションから License Manager インストール ファイルをダウンロードし

ます。詳細は、12 ページの「TestComplete のインストール パッケージの入手」を参照してください。 

2. License Manager PC となるネットワーク コンピューターを選択します。 

3. License Manager PC に License Manager ユーティリティをインストールします。 

4. デスクトップの [スタート] ボタン(または Windows ボタン) をクリックし、[すべてのプログラム] > 

[SmartBear] > [License Manager] > [Activate or Deactivate License] を選択します。これに

より [License Management] ウィザードが起動します。 

5. ウィザードの最初のページで、新しいライセンスをアクティベートするか、既存のライセンスのアク

ティベートを解除するかを選択します。 

6. 次のページで、アクティベートの方法を選択します: automatic (自動) または manual (手動)。簡単な

自動アクティベートを選択することを推奨します。自動アクティベートは、コンピューターがインター

ネットに接続されている必要があります。コンピューターがインターネットに接続されていない場合は、

手動アクティベートを選択してください。 
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選択したアクティベートの方法によって次の操作が異なります。詳細は、以下の「自動アクティベー

ト」と「手動アクティベート」を参照してください。 

Floating User (フローティング ユーザー) ライセンスが License Manager PC でアクティベートされると、ネット

ワーク上のほかのコンピューターでこのライセンスを使用して TestComplete を使用できます。 

自動アクティベート 

コンピューターがインターネットに接続されており、 SmartBear ライセンシング  Web サイト 

(https://ls1.smartbear.com または https://ls2.smartbear.com、ポート 443) にアクセスできる場合、[License 

Management] ウィザードは、自動アクティベートを使用します。ライセンスをアクティベートするには、次の

ステップに従ってください。 

• ウィザードで、アクティベート情報を指定します: ユーザー名、会社名、メール アドレスおよびライセ

ンス キー。 

ライセンス キーは、TestComplete ライセンスをリクエストした後に送付されるメールに記載されていま

す。あるいは、Web ページの My SmartBear セクションの TestComplete 14 製品ページで確認でき

ます。 

➢ https://my.smartbear.com 

ユーザー名、会社名、メール アドレスには、使用者のデータまたはライセンス保管者のデータを入

力することができます。使用者のデータを入力することを推奨します。 

アクティベート用の情報を入力したら、[Next] をクリックします。 

• ウィザード ページで、プロキシー認証設定を指定できます。これは、プロキシー経由で Web に接続

し、プロキシーが接続の際にユーザー認証を要求する場合に必要です。ほとんどのプロキシーは

認証を要求しないため、通常何も入力する必要はありません。プロキシーのタイプが不明な場合や

指定する証明書がわからない場合は、システム管理者に確認してください。 

• プロキシー設定を指定した後で、[Activate] をクリックします。ウィザードがアクティベート要求を 

SmartBear Web サーバーに送信し、アクティベート データを受信して、コンピューター上のライセン

スをアクティベートします。 

• ライセンスが正常にアクティベートされると、ウィザードは最後のページを表示します。そうでない場

合は、エラー メッセージと再度アクティベートするように促すメッセージが表示されます。 

注意: ライセンスをアクティベートするとき、ウィザードは、ポート 443 を介して、ls1.smartbear.com 

および ls2.smartbear.com の SmartBear ライセンス認証サイトと接続を確立します。プロキ

シー サーバー、ファイアウォール、ウイルス対策ソフトウェア等を使用している場合は、この 

Web サイトへのアクセスが許可されないことがあります。この場合、システム管理者に問い

合わせてプロキシー  サーバー、ファイアウォール、ウイルス対策ソフトウェア等で 

TestComplete が許可されるようにしてください。 

TestComplete ライセンスのアクティべートで問題が発生した場合は、TestComplete の パッ

ケージに含まれている『TestComplete 14 ライセンス ガイド』で解決策を検索してください。

あるいは、エクセルソフト株式会社までご連絡ください (40 ページの「SmartBear Software 

https://my.smartbear.com/
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へのお問い合わせ」を参照)。 

手動アクティベート 

コンピューターがインターネットに接続できない場合、または SmartBear ライセンシング Web サイトにアクセ

スできない場合は、手動アクティベートを使用します。このアクティベート方法は、手動で SmartBear Web 

サーバーとデータを交換します。そのため、Test Complete をインストールしたコンピューターと SmartBear 

Web サーバーを仲介する、インターネットに接続された別のコンピューターが必要になります。データを 

Test Complete をインストールしたコンピューターから仲介するコンピューターに送り、そのコンピューターか

ら Web サーバーに送ります。また受信も同様の方法で行います。 

ライセンスをアクティベートするには: 

• [License Management] ウィザードは SmartBear ライセンシング Web サイトへのアクセスに失敗す

ると、手動でライセンスをアクティベートするように促されます。オフライン (手動) アクティベーション

を選択します。 

• ウィザードで手動アクティベートの手順が表示されます。[Next] をクリックします。 

• ライセンスをアクティベートするには、コンピューターの情報が必要になります。ウィザードは、自動

的にこの情報を収集して、.c2v ファイルに保存します。ファイル名はウィザードに表示されます。 

評価版をアクティベートする場合は、評価版ライセンス キーもウィザードに表示されます。記憶する

か、メモしておいてください。 

[Next] をクリックします。 

• 次に、.c2v ファイルをインターネットに接続された仲介するコンピューターにコピーします。 

• ファイルをコピーした後で、仲介するコンピューター上で、次の URL をブラウザーで開きます。 

➢ https://my.smartbear.com/manual-license-activation/ 

ライセンスをアクティベートするための Web ページが開きます。Web ページで、ライセンス キー 

と .c2v ファイルの名前を指定します。 

ライセンス キーは、TestComplete ライセンスをリクエストした後に送付されるメールに記載されていま

す。あるいは、Web ページの My SmartBear セクションの TestComplete 14 製品ページで確認でき

ます (https://my.smartbear.com)。 

ライセンス キーとファイル名を指定した後で、[Send File] をクリックします。これで、ファイルが 

SmartBear Web サーバーにアップロードされます。ファイルの転送には時間がかかることがあります。 

• Web サーバーは、ファイルを処理して Test Complete をインストールしたコンピューター用のアクティ

ベート データを生成します。そして、このアクティベート用データ (ファイル拡張子は、.v2c) のダウ

ンロード用リンクを表示します。このファイルを仲介するコンピューターにダウンロードします。 

• 仲介するコンピューターから .v2c ファイルを Test Complete をインストールした PC にコピーします。

そして、Test Complete をインストールしたコンピューター上で、[License Activation] ウィザードの 

[Next] をクリックします。エディット ボックスを含むウィザードの次のページが表示されます。 

https://my.smartbear.com/manual-license-activation/
https://my.smartbear.com/
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• エディット ボックスで .v2c ファイルを指定して、[Activate] をクリックします。ウィザードは、コン

ピューターにアクティベート用データを保存し、ライセンスをアクティベートします。 

ウィザードは、アクティベートが正常に完了したことを表示するか、問題が発生した場合は、そのエ

ラーを表示します。 
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TestExecute ライセンスのインストールとアクティベート 

TestExecute は、TestComplete がインストールされていないコンピューターでテストを実行することができるリ

ソース フレンドリーな製品です。TestExecute は、スタンドアロン製品として購入できます。 

TestExecute のアクティベート方法は、評価版か製品版かによって異なります。TestExecute のインストールと

アクティベートに関する詳細は、『TestExecute 14 インストール  ガイド』および  TestExecute Help の

「Licensing」セクションを参照してください。以下は、インストールとアクティベートの要点です。 

• TestExecute は、スタンドアロン製品として購入し、ライセンスを受け取ることができます。 

• TestExecute を購入すると、そのライセンス キーが送付されます。Web サイトの My SmartBear セク

ションから TestExecute をダウンロードし、このライセンス  キーを使ってアクティベートします 

(https://my.smartbear.com)。詳細は、『TestExecute 14 インストール ガイド』および TestExecute Help 

の「Licensing」セクションを参照してください。 

https://my.smartbear.com/
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TestComplete のメンテナンスとアンインストール 

TestComplete のインストール プログラムには、インストールされた TestComplete 機能の追加や削除、または 

TestComplete インストールの修復などのメンテナンス タスクが含まれています。[コントロール パネル] からメ

ンテナンス モードでインストール プログラムを実行できます。 

TestComplete インストールの変更 

TestComplete インストール プログラムでは、必要に応じて TestComplete の機能のインストール/アンインス

トールを行えます。TestComplete のインストールを変更する前に12 ページの「ユーザー権限」で説明されて

いるようにユーザー アカウントに管理者権限があることを確認してください。 

TestComplete インストールを変更するには: 

• TestComplete およびテスト  アプリケーション、Web ブラウザー、Microsoft Visual Studio など 

TestComplete がサポートしている、あるいは統合されるその他のアプリケーションをすべて閉じます。 

• Windows Vista、Windows 7、またはそれ以降のオペレーティング システムの場合、[コントロール 

パネル] > [プログラムと機能] アプレットを開きます。 

Windows XP、Windows Server 2003 の場合、[コントロール パネル] > [プログラムの追加と削除] 

アプレットを開きます。 

• リストで SmartBear TestComplete 14 を選択し、[変更] をクリックします。TestComplete のインス

トール ウィザードが表示されます。 

• [Welcome] 画面で [Modify] を選択し、[Next] をクリックして処理を続けます。 

• 次に、[Select Features] 画面で、現在インストールされている TestComplete 機能を確認します。

追加する機能をオンにし、削除する機能をオフにします。[Next] をクリックして処理を続けます。 

• インストールの変更処理が完了するまで待ってから、[Modify Complete] 画面の [Finish] をクリッ

クします。 

TestComplete のアップデート 

最新の向上機能を活用できるように定期的に TestComplete を最新版へアップグレードすることを推奨し

ます。 

TestComplete アップデートの確認 

デフォルトでは、TestComplete の起動時に自動でアップデートが確認されます。自動アップデート確認機

能が有効なことを確認、あるいは動作を変更するには、次の操作を行います。 

• TestComplete のメイン メニューで [Tools] > [Options] をクリックします。 
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• 次に、[General] > [Show Again Flags] カテゴリをクリックします。 

• 起動時のオプションでアップデートの確認を有効または無効にします。 

また、TestComplete のメイン メニューから [Help] > [Check for Updates] をクリックして、アップデートを確

認することもできます。 

TestComplete の新しいバージョンが利用可能な場合、このバージョンのリリース ノートの表示とインストール 

パッケージのダウンロードが可能な SmartBear の Web サイトへのリンクを含むメッセージ ボックスが表示さ

れます。 

アップデートのインストール 

アップグレード処理は、アップグレード対象の TestComplete バージョンが現バージョンのアップデートかま

たは新しいメジャー バージョンかにより異なります。 

• 現バージョンのアップデートをインストールする場合は、既存のインストールに上書きしてインストー

ルできます。インストール プログラムにより、既存の TestComplete インストールが検出され、必要な

ファイルが更新されます。この場合、カスタマイズされた TestComplete の設定とライセンス情報は維

持されます。 

• 新しいメジャー バージョンにアップグレードするには、既存のインストールをアンインストールしてか

ら新しいバージョンをインストールする必要があります。アンインストールの方法については、30 

ページの「TestComplete のアンインストール」を参照してください。 

新しい TestComplete バージョンのインストール方法については、16 ページの「TestComplete のインストー

ル」を参照してください。 

TestComplete の修復 

TestComplete インストール プログラムでは、破損や不注意で削除してしまった場合に修復が可能です。修

復処理により、TestComplete インストール、TestComplete 固有のレジストリ キー、ファイルの関連付けなどか

らの破損ファイルや削除されたファイルが復元されます。 

TestComplete インストールの修復を開始する前に、次の事項を確認してください。 

• TestComplete を修復するには、12 ページの「ユーザー権限」の説明にあるようにユーザー アカウン

トに管理者権限が必要です。 

• 修復処理では、TestComplete の設定がデフォルトにリセットされます。カスタマイズ設定がある場合

は、ファイルにエクスポートして、修復後に復元できるようにしてください。詳細は、31 ページの

「TestComplete 設定のインポートとエクスポート」を参照してください。 

TestComplete を修復するには: 

• TestComplete が実行中の場合はプログラムを終了します。また、Microsoft Visual Studio、Web ブラ

ウザー、テスト アプリケーションなど TestComplete がサポートしている、あるいは統合されるその他

のアプリケーションが開いている場合は閉じてください。 
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• Windows Vista、Windows 7、またはそれ以降のオペレーティング システムの場合、[コントロール 

パネル] > [プログラムと機能] アプレットを開きます。 

Windows XP、Windows Server 2003 の場合、[コントロール パネル] > [プログラムの追加と削除] 

アプレットを開きます。 

• リストで SmartBear TestComplete 14 を選択し、[変更] をクリックします。TestComplete のインス

トール ウィザードが表示されます。 

• [Welcome] 画面で [Repair] を選択し、[Next] をクリックして処理を続けます。 

• 処理を続けるかどうかを確認するダイアログが表示されたら、[Yes] をクリックします。 

• 修復処理が完了するまで待ってから、[Repair Complete] 画面の [Finish] をクリックします。 

TestComplete のアンインストール 

TestComplete をアンインストールする前に、12 ページの「ユーザー権限」の説明にあるようにユーザー アカ

ウントに必要な権限があることを確認してください。 

また、TestComplete を別のコンピューターに移行する場合には、次の事項を考慮してください。 

• Node-Locked User (ノードロック ユーザー) ライセンスの場合、TestComplete をアンインストールする

前にライセンスのアクティベートを解除します。詳細に関しては、TestComplete ヘルプの

「Licensing」セクションで「Deactivating Licenses」を参照してください。ライセンスのアクティベート解

除については、SmartBear 営業窓口までお問い合わせください。連絡先情報は、40 ページの

「SmartBear Software へのお問い合わせ」を参照してください。 

• TestComplete のカスタマイズ設定をファイルにエクスポートしておくと、設定を新しいインストールに

移行できます。詳細は、31 ページの「TestComplete 設定のインポートとエクスポート」を参照してく

ださい。 

TestComplete をアンインストールするには: 

• TestComplete が実行中の場合はプログラムを終了します。また、Microsoft Visual Studio、Web ブラ

ウザー、テスト アプリケーションなど TestComplete がサポートしている、あるいは統合されるその他

のアプリケーションが開いている場合は閉じてください。 

注意: アプリケーションから TestComplete のヘルパー モジュールをアンロードするのには時間が

かかります。TestComplete 終了後、数分待ってからアンインストールを開始することを推奨

します。 

• Windows Vista、Windows 7、またはそれ以降のオペレーティング システムの場合、[コントロール 

パネル] > [プログラムと機能] ウィンドウを開きます。 

Windows XP、Windows Server 2003 の場合、[コントロール パネル] > [プログラムの追加と削除] 

アプレットを開きます。 

• リストで SmartBear TestComplete 14 を選択し、[削除] (または同様の機能) をクリックします。 
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• TestComplete のアンインストール処理を続けるかどうかを確認するダイアログが表示されたら、

[Yes] をクリックします。 

• 画面の説明に従って、アンインストール処理を完了します。 

注意: TestComplete は、NET アプリケーションからモジュールをアンロードできません。

TestComplete モジュールがロードされたままであることを検出すると、インストール ウィ

ザードは [File in Use] ダイアログと使用中のプロセスのリストを表示します。それらの

プロセスを終了するか、実行を継続するか (後でコンピューターの再起動が必要にな

ります) 選択できます。 

• [Uninstall Complete] 画面で [Finish] をクリックします。 

TestComplete をアンインストールする際、作成したテスト プロジェクトは削除されません。TestComplete のプ

ロジェクト フォルダーを削除することにより、手動で削除できます。デフォルト フォルダーの場所は次のとお

りです。 

• <SystemDrive>:\Users\<UserName>\Documents\TestComplete 14 Samples (Windows Vista 、

Windows 7 およびそれ以降のオペレーティング システムの場合) 

• <SystemDrive>:\Documents and Settings\<UserName>\My Documents\TestComplete 14 Samples 

(Windows XP、Windows Server 2003 の場合) 

TestComplete 設定のインポートとエクスポート 

TestComplete の全設定あるいは一部をファイルにエクスポートして、いつでもインポートすることが可能です。

これは、TestComplete の古いバージョンからの移行や、TestComplete を別のコンピューターに移動、または

複数の TestComplete インストールに同じ設定を適用する際に役立ちます。また、これにより TestComplete 

のカスタマイズ設定のバックアップも作成できます。 

TestComplete 設定をファイルにエクスポートするには: 

• TestComplete のメイン メニューで [Tools] > [Settings] > [Export Settings] をクリックします。

[Export Settings] ダイアログが表示されます。 

• 保存する設定カテゴリを選択します。 

• [Settings file name] ボックスで、設定を保存する .acnfg ファイルの保存先と名前を入力します。

保存先を参照するには、省略記号のボタンをクリックします。 

• 次に、[Export] をクリックして、指定したファイルに設定を保存します。 

TestComplete 設定をファイルからインポートするには: 

• TestComplete のメイン メニューで [Tools] > [Settings] > [Import Settings] をクリックします。

[Import Settings] ダイアログが表示されます。 

• こ の  [Import from file] リ ス ト で 、 設 定 が 保 存 さ れ た フ ァ イ ル を 指 定 し ま す 。 

リストが空の場合は、[Browse] をクリックして、対象の .acnfg ファイルを開きます。 
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• [Settings available to import] で、現在の設定に適用する設定カテゴリを選択します。[Check 

All] ボタンと [Uncheck All] ボタンを使用すると、すべての項目をそれぞれ、選択、解除できます。 

• [Import] をクリックして、指定した設定を適用します。 

ファイルに含まれていない設定やリストで選択されていない設定はそのままです。 
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TestComplete のサイレント モードによるインストール 

場合によっては、TestComplete をサイレント モードでインストールする必要があるかもしれません。このモー

ドでは、ユーザーの介入なしにインストールが自動的に行われます。たとえば、TestComplete のインストー

ル処理を自動で行う場合や、TestComplete をネットワーク内の複数のコンピューターにインストールする場

合に、サイレント モードでインストールします。 

コマンドライン引数を利用して、TestComplete をサイレント モードでインストールできます。 

利用規約に同意する 

 TestComplete をサイレント モードでインストールすることにより、以下を含むすべての使用条件に同

意したことになります。 

• smartbear.com/terms-of-use/ 

• smartbear.com/legal/third-party-software-license-information/testcomplete-family/ 

• developers.google.com/terms/ 

サイレント インストールの実行 

1. TestComplete インストール パッケージをターゲット コンピューターに展開します。 

2. ターゲット コンピューターで、必要なコマンドライン引数を使用してインストールを実行します。 

例: 

<path_to_installation_package>\TestComplete1490_Release.exe -SilentInstall 

3. インストール プログラムは、ユーザーの介入なしに TestComplete をインストールします。 

サポートされているコマンドライン引数 

次のコマンドライン引数を使用して、TestComplete インストール パッケージを起動し、サイレント モードでイ

ンストールできます。 

インストール パッケージは、次のコマンドライン引数をサポートしています。 

<TestComplete1490_Release.exe> [<mode> <options> <modules>][/?] 

モード 

次のいずれかでなければなりません。 

https://smartbear.com/terms-of-use/
https://smartbear.com/legal/third-party-software-license-information/testcomplete-family/
https://developers.google.com/terms/
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-Install 

インストール プログラムにインタラクティブ (GUI) モードで実行するように指示します。 

-SilentInstall 

インストール プログラムにサイレント モードで実行するように指示します。 

-SilentUninstall 

インストール プログラムにサイレント モードで製品をアンインストールするように指示します。 

-Uninstall 

インストール プログラムにインタラクティブ (GUI) モードで製品をアンインストールするように指示し

ます。 

注意: 

• -Uninstall または  -SilentUnInstall 引数を指定すると、ほかのコマンドライン引数は無視され 

TestComplete がアンインストールされます。 

• TestComplete をアンインストールするには、現在インストールされている TestComplete バージョンの

インストール パッケージを使用する必要があります。 

オプション 

次の引数はオプションで指定できます。引数の値にスペースが含まれる場合は、値を二重引用符で囲んで

ください。 

例: 

-log="C:\my install files " 

-Log=Log_Path 

インストール ログを指定したフォルダーに保存します。 

例:  

-log=C:\source 

フォルダー名を省略すると、ログはインストール パッケージがあるフォルダーに保存されます。 

-log 

-InstallPath=Application_Path 

TestComplete は指定したフォルダーにインストールされます。 

-ExternalData=Data_Path 

TestComplete は、指定した外部インストール パッケージ (.exe) を使用してインストールされます。 
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-CleanUp 

TestComplete とすべての機能がコンピューターから削除され、インストール情報が Windows の [プ

ログラムと機能] から削除されます。通常のアンインストールですべての製品ファイルがコンピュー

ターから削除されなかった場合に使用します。 

モジュール 

-IntelligentQuality, -Desktop, -Web, -Mobile 

指定したモジュールとアドオンがインストールおよびアクティベートされます。 

 Intelligent Quality アドオンをサイレントモードでインストールすることにより、サードパーティの使用

条件に同意したことになります。 

➢ developers.google.com/terms/ 

モジュールまたはアドオンが引数パラメーターとして指定されていない場合、モジュールまたはアドオン

はインストールされません。たとえば、次のコマンドでは、Desktop と Mobile モジュールがインストールさ

れますが、Web モジュールとアドオンはスキップされます。 

<path_to_installation_package>\TestComplete1490_Release.exe -SilentInstall 

-Desktop -Mobile 

次のコマンドでは、Desktop モジュールと Intelligent Quality アドオンがインストールされますが、Web モ

ジュールと Mobile モジュールはスキップされます。 

<path_to_installation_package>\TestComplete1490_Release.exe -SilentInstall 

-Desktop -IntelligentQuality 

インストール時にモジュールやアドオンを指定しない場合、すべての利用可能なモジュールとアドオン

がインストールされます。 

インストールに関するヘルプ 

利用可能なコマンドライン引数を表示するには、/? 引数を指定してインストール パッケージを実行します。 

<TestComplete1490_Release.exe> /? 

ほかのすべてのコマンドライン引数は無視されます。 

サイレント インストールの確認 

サイレント モードでは、インストール ウィザードはメッセージを表示しません。-Log コマンドライン引数を使用

すると、ログ ファイルを作成し、すべての進捗状況を書き込むようにインストールを設定できます。インストー

ルが完了したら、ログファイルを調査して、インストール時に起こったこととインストール結果を確認できます。 

https://developers.google.com/terms/


トラブルシューティング 

www.smartbear.com TestComplete by SmartBear Software 

36 

トラブルシューティング 

インストールに関する問題 

このセクションでは、TestComplete のインストール中に発生する可能性のあるエラーとその解決方法を説明

します。インストール中に問題が発生した場合、インストール プログラムは、インストール ログを保存すること

を提案します。ログにはすべてのインストール イベントに関するデータが含まれます。このログをカスタマー 

ケア チームに送信できます。連絡先の情報は、40 ページの「SmartBear Software へのお問い合わせ」を参

照してください。 

Error: Some installation files are corrupt.Please download a 

fresh copy… (一部のインストール パスが破損しています。インストー

ル パッケージを再度ダウンロードしてください…) 

このメッセージは、TestComplete インストール パッケージが破損している場合に表示されます。この問題は、

さまざまな理由により発生します。インストール パッケージをダウンロードし直して、インストールを再度実行

してください。 

Error 1304.Error writing to file tcWPFHelpers.dll. (tcWPFHelpers.dll 

ファイルの書き込みエラー) 

このエラーは、インストール プログラムが TestComplete の WPF Controls Support プラグインの一部である 

tcWPFHelpers.dll アセンブリを、コンピューターの Global Assembly Cache (GAC) にインストールするのに失

敗したときに発生します。次の表は、考えられる原因をまとめたものです。 

考えられる原因 解決法 

ユーザー  アカウントに  Global 

Assembly Cache (GAC) へのファ

イルの書き込み権限がない。 

12 ページの「ユーザー権限」で説明されているように、管理者権限

のあるアカウントでインストールを実行してください。 

TestComplete をインストールするコンピューターでユーザー アカウ

ントに管理者権限がない場合は、システム管理者にお問い合わせく

ださい。 
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考えられる原因 解決法 

.NET Framework インストールが

破損している。 

メンテナンス モードで .NET Framework インストール プログラムを実

行し、[修復] オプションで .NET Framework インストール プログラム

を修復します。 

次の操作を行います。 

• Windows Vista、Windows 7、またはそれ以降のオペレー

ティング システムの場合、[コントロール パネル] > [プログラ

ムと機能] アプレットを開きます。 

Windows XP、Windows Server 2003 の場合、[コントロール 

パネル] > [プログラムの追加と削除] アプレットを開きます。 

• リストで .NET Framework を選択し、[変更] をクリックしま

す。.NET Framework のセットアップ プログラムが表示されま

す。 

• [修復] オプション (または同様のオプション) を選択して、[次

へ] をクリックします。 

• 画面の説明に従って、修復処理を完了します。 

複数のバージョンの .NET Framework がインストールされている場

合は、すべてのバージョンを修復する必要があります。 

TestComplete の WPF Controls Support プラグインが不要な場合 (たとえば、WPF アプリケーションをテスト

しないなど) は、インストールから除外します。この場合、TestComplete のインストール時に  [Select 

Features] 画面で [Extensions] > [Open Applications Support] > [WPF Controls Support] 機能

をオフにします。 

Error 1320.The specified path is too long C:\ProgramData\ 

Documents\TestComplete 14 Samples (指定されたパスが長過ぎます) 

この問題は、コンピューターに Windows 7、Windows Vista、Windows Server 2008 オペレーティング システ

ムが事前にインストールされている (ネットブックなど) 場合に発生します。これは、[共有ドキュメント] フォル

ダーではなく、存在していないディレクトリを解決する <SystemDrive>:\ProgramData\Documents の無効な

ジャンクション ポイントが原因です。ジャンクション ポイントの詳細は、MSDN の記事の「ジャンクション ポイ

ント」を参照してください。 

➢ https://docs.microsoft.com/en-us/windows/win32/vss/junction-points 

ジャンクション ポイントが正しいかどうかを確認するには: 

• 管理者権限で、[コマンド プロンプト] を管理者として実行します。 

➢ [スタート] をクリックして、[検索] ボックスに cmd.exe と入力します。 

➢ 検索結果の cmd.exe を右クリックして、[管理者として実行] をクリックします。 

https://docs.microsoft.com/en-us/windows/win32/vss/junction-points
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• 次のコマンドを [コマンド プロンプト] に入力して、Enter を押します。 

dir C:\ProgramData /al 

(オペレーティング システムが C 以外のドライブにインストールされている場合は、ドライブ名のアル

ファベットを変更してください。)  

• Documents ジャンクション ポイントのパスを確認します。 

➢ [C:\Users\Public\Documents] の場合 (システム ドライブが C: と仮定)、ジャンクション ポイントは

正しいです。 

➢ 無効なドライブ名、たとえば [S:\Users\Public\Documents] などの場合は、ジャンクション ポイント

は破損しています。 

• ジャンクション ポイントを修正するには、[コマンド プロンプト] で次のコマンドを実行します。 

rd C:\ProgramData\Documents 

mklink /j C:\ProgramData\Documents C:\Users\Public\Documents 

(オペレーティング システムが C 以外のドライブにインストールされている場合は、ドライブ名のアル

ファベットを変更してください。) 

ジャンクション ポイントの修正後、Modify モードで TestComplete インストール プログラムを実行し、サンプル 

アプリケーションとテスト プロジェクトをインストールします。詳細は、28 ページの「TestComplete インストー

ルの変更」を参照してください。 

TestComplete サンプルが不要な場合は、インストールから除外できます。この場合、TestComplete のインス

トール時に [Select Features] 画面で [Samples] 機能をオフにします。 

また、オペレーティング システムのインストール時にジャンクション ポイントが正しく設定されていない場合

は、コンピューターの製造元に問い合わせることをお勧めします。 

Error 1628. Failed to complete installation (インストールを完了でき

ませんでした) 

このエラーは、通常 Windows XP 64 ビット版を実行しているコンピューターで発生します。 

このエラーは、Windows Installer が TestComplete インストール パッケージが正しく署名されているか確認

するのに十分なメモリがないために発生します。 

問題を解決するには、Windows Installer が任意のサイズのインストール パッケージを確認できるようにソフ

トウェア制限ポリシーを設定します。 

1. 問題の発生したコンピューターで、ローカル セキュリティ設定を実行します。[スタート] > [ファイル

名を指定して実行] を選択して、secpol.msc と入力し、Enter を押します。 

2. 左側のセクションで [セキュリティの設定] > [ソフトウェアの制限のポリシー] を選択します。 

3. ソフトウェアの制限のポリシーが定義されていない場合は、[ソフトウェアの制限のポリシー] を右ク

リックして [新しいソフトウェアの制限のポリシー] を選択します。 
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4. 右側のセクションで、[強制] を右クリックし、[プロパティ] をクリックします。 

5. [強制のプロパティ] ダイアログの [ソフトウェアの制限のポリシーの適用ユーザー] セクションで、

[ローカルの管理者を除くすべてのユーザー] を選択します。 

6. [OK] をクリックして変更を保存し、[強制のプロパティ] ダイアログを閉じます。 

7. 変更を有効にするためにコンピューターを再起動します。 

8. TestComplete を再インストールします。 

TestComplete をインストールしたら、[ソフトウェアの制限のポリシーの適用ユーザー] オプションの値を [す

べてのユーザー] に戻します。 

ライセンスに関する問題 

ライセンスのアクティベート時に発生する一般的な問題の説明については、TestComplete ドキュメントの

「Licensing」セクションを参照してください。 
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SmartBear Software へのお問い合わせ 

TestComplete のインストールに関する質問、またはインストールやライセンスについての問題に関する質問

は、SmartBear サポート窓口までお問い合わせください。質問は、次の Web サイトから送ることができます。 

➢ https://support.smartbear.com/message/?prod=TestComplete 

ライセンスのアクティベート、メンテナンス、アクティベート解除については、SmartBear 営業窓口までお問い

合わせください。 

• 電話: +1 617-684-2600 

• Email: sales@smartbear.com 

SmartBear (SmartBear) のサポート方針については、Support ポータルを参照してください。 

➢ https://support.smartbear.com 

エクセルソフト株式会社へのお問合せ 

TestComplete に関する質問、問題、その他のお問い合わせについては、エクセルソフト株式会社の下記の

お問合せページからお気軽にご連絡ください。 

➢ https://www.xlsoft.com/jp/services/xlsoft_form.html 

https://support.smartbear.com/message/?prod=TestComplete
mailto:sales@smartbear.com
https://support.smartbear.com/
https://www.xlsoft.com/jp/services/xlsoft_form.html?option2=SmartBear_TestComplete
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